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1 About This Guide

This guide provides information related to the functionality and usability of Siren Field

User. It is intended for use by mobile health care professionals to capture patient care

information when and where it is needed.
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2 Getting Started

2.1 Logging On

The first step to creating an ePCR with Siren Field User is to login with a valid System

User ID. System User's are registered with Siren Field User and have a valid username and

password.

Step 1: Click the Siren Field User icon.  

The logon screen will then appear. 

Step 2: Enter the information in all available fields on the top of the page. 

Note: Your screen may display different information for entry based upon your organization’s

preference. 

Step 3: Click the ADD SYSTEM USER button.  
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Step 4: Enter a valid Username and Password (password is case sensitive). 

Step 5: Click LOGON. Your user information will be populated. 

Step 6: Enter any additional user information under the ‘Crew Information’ section. 

Step 7: Click OK. 

Step 8: Continue to add other users and assign crew members types.

Step 9: Once all users have been added, click OK. 

By default, all crew members that have been set via the Logon screen will be identified as crew

for each ePCR created.  Crew lists for individual ePCRs may be adjusted as required.



Getting Started 9

Copyright © 2016 Medusa Medical Technologies, Inc.  

2.2 Adding Other Users

Adding System Users

Paramedical staff who are registered with Siren Field User and have a valid

username and password.

Adding Non-System Users

Users who do not have a user account within the Siren system, but are able to

provide care to the patient and are able to document treatment details. For

example, treatment provided by a medical first responder before paramedics

arrive on scene can be entered by a non-system user.
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2.3 Crew Member Types

Primary Crew

If only one System User logs on they will be considered the Primary Crew member

by default. If two or more system users have logged on, the Primary Crew member

can be identified by selecting the crew and clicking this icon. Marking someone as

the Primary Crew member identifies them as the primary patient caregiver.

Secondary Crew

When there are multiple crew members, the Secondary Crew member can be

identified by selecting the crew and clicking this icon.

Third Crew

When there are multiple crew members, the Third Crew member can be identified

by selecting the crew and clicking this icon.

Unspecified  Crew

By default, all crew are considered Unspecified Crew members until their position

is explicitly identified.  This designation is also used if there are more than three

crew members.  You can also define a previously defined crew position (primary,

secondary, third) as unspecified by selecting the crew and clicking this icon.

 

An unlimited number of system and non-system users can logon to Siren Field User;

however, Primary, Secondary and Third Crew members can only be assigned once. An

unlimited number of Unspecified Crew members may be identified.  

Reminder: If there is only one logged on System User, they will be automatically set as the

Primary Crew member.
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2.4 Other Functions on Logon Page

Edit

Edit the information for any user.

Delete

Delete a user from the current crew list.  This prevents the user from being assigned

to ePCRs that are created by the current crew. 

 

2.5 Changing Logon Information

Crew Members who leave or arrive during a shift can logon or logoff. 

While an ePCR is open, follow these steps to update the crew: 

Step 1: Click MENU. 

Step 2: Click FILE. 

Step 3: Click LOGON/LOGOFF.
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This will bring you back to the logon page where you can make changes to the users. 

Step 4: Add or change users and assign crew members types.

Step 5: Once all users have been updated, click OK. 

Note: New ePCRs created after these changes will reflect the new crew selections. 
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3 Patient List

The first screen displayed after logging on is the Patient List screen. It lists current ePCRs

associated with the logged on Crew members. This section can also be accessed by

selecting the Menu button. 

3.1 Understanding the Patient List Screen

Each record on the Patient List screen displays the name, run number, type of patient (real

or practice), age, gender, patient outcome, finalized status, mandatory overrides, and the

date and time that the ePCR was created.
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3.2 Button Selections

The following buttons are included at the top of the Patient List screen.

Add

Create a new ePCR.

Edit

Edit or enter data within an existing ePCR.

View

View the ePCR Report.

Comments

View comments associated with ePCRs that have been sent back to the Primary

Crew member.

Delete 

Delete an ePCR.  This removes the ePCR from this instance of Siren Field User; not

from the Siren system.

Request ePCR   

Request a deleted ePCR be sent back to the tablet. This can only be done with

unfinalized ePCRs associated with the requesting User.

Transfer ePCR

For the System User to transfer an ePCR to another System User. This can only be

performed with unfinalized records.

Practice

Create a practice ePCR; thereby, differentiating the ePCR from records pertaining

to real patients.

Refresh   

Refresh the Patient List screen. 

Note: The screen automatically refreshes when returning from ePCR edits.  You can manually

refresh the view if you have not been navigating to other areas of the application for long

periods of time.
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Darken the screen to eliminate glare, and provide privacy when in

public spaces.

View calls that have been downloaded from CAD.

Return from the Patient List screen to the open ePCR. 
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4 Understanding Siren Field User Layout

This section of the User Guide provides a tour of Siren Field User. It begins with a

description of the major screen components, followed by details concerning the functions

available within each component. 

The major screen components are shown below.

Note: Due to differing customer needs, there is some variation in configuration. Buttons may

have different names however, the type of information gathered in each section does not

change. 
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4.1 Menu Button

Selecting the Menu button expands to show a list of options.
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4.1.1 Menu Button Items

File > Undock

This option is used with older type docking stations that do not automatically handle

disconnections from Windows. It is not needed for new hardware.

File > Change Password 

When configured ‘on’, this option allows you to perform a password reset.

File > Logon/Logoff 

If you leave or arrive during a shift you can logon or logoff by selecting the Logon/Logoff

option. New ePCRs created after these changes will reflect the new crew selections. 

For example, ePCRs created while the crew member was logged on will default to them

being listed as a crew member, while those ePCRs created after a crew member logs off

will not list that individual as a crew member.  

File > Exit 

Selecting this option closes the Siren Field User application for all users.

Scan 

Used when swiping/scanning cards such as a Health Card or Driver’s License.

New Patient 

To create a new ePCR.

Patient List 

To go back to the Patient List screen.

CAD List

To display CAD calls that have been forwarded to the crew based upon Unit ID. 

Current ePCR > Comments

To enter free text information about the patient in the current ePCR.

Current ePCR > Attach/Detach 

To attach documents or photos to the ePCR. 

Current ePCR > View Transfer Comments 

Displays comments entered when a Web User sends an ePCR to the primary crew member.

Current ePCR > Switch to Practice ePCR 

Turns the current ePCR into a practice ePCR.



Understanding Siren Field User Layout 19

Copyright © 2016 Medusa Medical Technologies, Inc.  

View > Dark Screen 

To darken the screen to eliminate distraction and increase privacy when driving or in public

spaces.

Help > About Siren ePCR 

To view information about the current version of Siren software.
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4.1.2 Adding Attachments

Siren Field User allows you to attach files to an ePCR from the Menu Button options. This

file remains attached to the ePCR and is viewable from the tablet PC or the Siren ePCR

Server. When attached to an ePCR, any attached documents or photos will not be

automatically printed; they must be manually opened and then printed.  

The SHOW DETAILS button hides the image preview pane and displays all the comments

associated with attached files. You can toggle between the preview and comments at any

time.

Note: This section is to be user for general attachments. To attachment diagnostics please see:

Diagnostics
104
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To attach a file to an ePCR:

Step 1: Click MENU.

Step 2: Click CURRENT ePCR.

Step 3: Click ATTACH/DETACH.

The Attach/Detach screen will appear.

Step 4: Click the ADD button. 

The Browse screen will appear. 
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Step 5: Find the location of the File and Select it. 

Step 6: Click OPEN. 

The file will then be added to the list of ePCR attachments and will now be seen in the

Attach / Detach screen. 

The attached file will also be listed at the bottom of the printed ePCR.
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Step 7: Click OK. 

4.1.2.1 Renaming Attachments & Adding Comments

You can add comments to attachments however, it is optional. 

To change the name, document the kind of file or add comments: 

Step 1: Click MENU.

Step 2: Click CURRENT ePCR.

Step 3: Click ATTACH/DETACH.

The Attach/Detach screen will appear. 

Step 4: Select one of the attachments listed. 

Step 5: Click EDIT.  

The Attachment Details screen will appear. 

Step 6: Enter the new name and/or Enter a comment.
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Step 7: Click OK. 
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4.1.2.2 Opening and Modifying Attached Files

To open and modify files:

Step 1: Click MENU.

Step 2: Click CURRENT ePCR.

Step 3: Click ATTACH/DETACH.

The Attach/Detach screen will appear. 

Step 4: Select one of the attachments listed. 

Step 5: Click OPEN FILE button. 

The file will open within the application associated with that file type. 

Note: Files can only be opened and edited if the accompanying software is installed on the

tablet. For example, if the file is a Microsoft® Word file, Microsoft® Word must be installed on

the tablet in order to edit the file. A message stating "Required program is not available" is

displayed if the software is not installed.

Step 6: Modify the file and then Save the file from the appropriate software (such as

Microsoft® Word).

Step 7: Click SAVE.
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4.1.2.3 Printing Attached Files and Forms

Files can be printed while open using the software associated with that file type.

To print attached files:

Step 1: Click MENU.

Step 2: Click CURRENT ePCR.

Step 3: Click ATTACH/DETACH.

The Attach / Detach screen will appear. 

Step 4: Select one of the attachments listed. 

Step 5: Click OPEN FILE button. 

The file will open within the application associated with that file type. 

Step 6: Print the file from the associated software and then close the file. 

This will take you back to Siren Field User Attach/Detach screen. 

Step 7: Click SAVE.
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4.1.2.4 Detaching Files

Files can be detached from the ePCR. 

To detach a file from an ePCR:

Step 1: Click MENU.

Step 2: Click CURRENT ePCR.

Step 3: Click ATTACH/DETACH.

The Attach/Detach screen will appear. 

Step 4: Select one of the attachments listed. 

Step 5: Click DETACH. 

The Detach confirmation screen will appear.  

Step 6: Click YES.   

Step 7: Click SAVE.

Note: To detach all the files from an ePCR, click   in Step 5 above.
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4.2 Information Bar

The information bar provides easy access to key patient identifying information, CAD, and

Siren server communications.

Comments

Click to enter/view additional information about the patient or surroundings.

Incident Number

This is populated from Incident Number entered in the Incident section. 

Patient ID

Includes the patient’s name, age, and gender and is populated from the Patient

ID section.

Note: First and Middle names are displayed on the Information Bar as initials only. 

Chief Complaint

This section displays the patient’s Chief Complaint. 

Current Time

This section displays the current time on the tablet.

If CAD data has been applied to this ePCR, the circle identifies the number of

pieces of CAD data conflicting with manually entered information. 

Click this icon to view the CAD Reconciliation screen and resolve the conflicts.

If no CAD data has been applied to this ePCR, click to view a list of available

CAD events. 

  
Communications

Refer to section below. 

Message Counter

The number below the communication lights is a message counter to indicate

the number of unsent message packages queued for the server.

Note: Message count will increment to 500 with a > symbol to indicate additional

unsent messages.
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4.3 Communication Lights

Two lights are located in the top right of the Information Bar as well as in the task menu.

The number under the communication lights is the number of messages waiting to be sent

to the server.

Data Event Status (Left Light)

Indicates whether data is waiting to be sent to the server. 

 

Yellow left light

Indicates there is data waiting to be sent to the server. 

 
Green left light

Indicates that all data has been sent. ‘When the lights are green, the trap is clean’

so you should see ‘0’ messages.

Communication Status (Right Light) 

Indicates if there is a clear connection to the server. 

 

Yellow right light

Indicates that the tablet is negotiating a connection with the server.

Green right light

Indicates a clear connection to the server.

Red right light

Indicates there is no connection to the server. If there is no communication with

the server, there are functions that will no longer be available on the tablets. These

include patient lookup, ePCR transfer, CAD import, Siren Notification Board

updates and others. 

You can still document ePCRs on the tablet. Once communication is reestablished

the messages will flow automatically.

 

Two Green lights- 

Indicates the tablet is connected to the server and sending information.

Note: You may continue to enter information into Siren Field User with or without

connectivity. 
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4.4 Connectivity & Version Checks

To prevent upgrades and limited network connectivity from interrupting a medic’s access to

their unfinalized ePCRs, as well as avoid version conflicts, we have implemented the

following strategic checks in Siren:

Network Connectivity Checks 

When a network connection is not present, activities requiring a network connection (e.g.

Auto ePCR Removal & Retrieval, Transfer via Server) will not be permitted. Related user

messaging has been implemented.

Version Checks 

In an upgrade scenario, field devices temporarily operate at lower software versions than

the server. To prevent version compatibility issues (e.g. a tablet running a lower version of

Siren from receiving an ePCR from an upgraded server / tablet), when Siren detects a

version difference or is unable to check the server version, it will not permit you to perform

operations that are affected by version differences (e.g. Auto ePCR Removal & Retrieval

and transfer). Upon launching, Siren Field User, Siren Server, and Siren Web do a check to

verify the installed application files have the same version as the database to which they

are connected. If there is a mismatch, the Siren component will not start, and a dialogue

will inform you of the problem.

Version Details

You can view the version details by clicking Menu > Help > About Siren ePCR.

4.5 SOAP Bar

The SOAP Bar is the buttons at the bottom of the screen that permit you to navigate

between the major areas of the software. These buttons are arranged from left to right in

logical order for use during assessment and treatment. The major functions associated with

each button are described in the “Principle Application Sections” of this document.

Note: Variations in configuration may have different button names; however, the type of

information gathered in each section does not change. 
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4.6 Side Navigation Control

The Side Navigation Control displays buttons that relate to the SOAP bar button selected.

Selecting a SOAP bar button displays related sections (e.g. Care Plan). The buttons

displayed in the control can either be stand-alone or accordions which can be expanded to

display subsections (e.g.  Working Diagnosis, Care Plan etc).

Side navigation remains collapsed by default. To facilitate more efficient application

navigation, Siren will remember previous navigations during an individual viewing of the

ePCR, but will not automatically expand the navigation control to show the selected item. 
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5 Entering ePCR Information in Siren Field User

There are several data entry points within Siren. Once you understand the various types of

data entry it will make documentation more efficient.  

These include:

Numeric fields

Date/Time fields

Free Text

Pick List

Summary Pick Lists

Long Caption Pick List

Magnetic Swipe Card, Bar Code Reader & QR Code Reader

Computer Aided Dispatch (CAD)

ECG & Monitor - Universal Defibrillator/Monitor Interface

ePCR Transfers

*Click link above or proceed to page number listed for more information. 

33

34

36

37

42

44

47

48

53

69
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5.1 Numeric Fields

Numeric fields accept numbers only. These fields are marked with   to indicate a

numeric value is required. The Weight field in the screenshot below is an example of a

numeric field.

Tip: Within Vitals, pressing Enter in a numeric field will take you from the numeric field of one

vital, to the first field of the next vital sign.
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5.2 Date & Time Controls

Siren displays a Date/Time control for fields requiring date/time entries. Invalid entries are

greyed-out or not included to ensure the integrity of entered data. For example, February

31, 2015 is not a selectable option. Likewise, fields that require a time value to be entered

only accept input values that fall within the 24-hour clock. For example, 27:00:00 is not a

selectable option. 
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5.2.1 Date & Time Button Selections

Siren Field User makes entering date and time information as quick and easy as possible

with special date/time data entry tools.

Selecting fields containing this icon, will display the full date control. 

Selecting this button, or fields containing this icon, will display the full date/time

control. See the screenshot below for the date and time view of this control.

Within forms, this button automatically enters the current date/time without

requiring you to navigate to the date/time control.

This button allows you to toggle between the ‘date and time’ screen to ‘time

only’ (i.e. the calendar portion of the screen is hidden).

 

  

Sometimes date and time information for a field may be unknown. The event may have

happened before medics were contacted, or it may be occurring at the present moment. To

ensure accuracy and ease of entry, date / time popups display the following buttons.
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The date and time will be recorded as a text value of “Prior to Arrival”.

  

              

The date and time will be recorded as the current date and time.

  

              

The date and time will be recorded as a text value of “Unknown”.

5.3 Free Text

Last Name and First Name fields are examples of free text fields. These fields have no

associated pick lists or controls and allow you to manually enter text using a physical

keyboard or the virtual on-screen keyboard.
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5.4 Pick Lists

Depending upon the number of items in a list, Siren may display the items on the screen all

at once or via a pick list icon. 

For fields with a limited number of options, such as Gender that only has three possible

selections (Female, Male, Not Known), pick list items are displayed directly on the screen.

See the screenshot below:

Siren also has many larger pick lists that cannot be accommodated on the main screen.

These include lists of Cities, Countries, Hospitals and Physicians, etc. For pick lists with many

items, a pick list icon displays to allow you to access a full list of the options available for

that field.

The pick list icon appears adjacent to fields with many items. Selecting the pick

list icon opens the window displaying the additional options for that field. 
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5.4.1 Using the Pick List Search Bar

Within this larger Pick List screen, there is a toolbar allowing you to search or scroll the list

of available field items.  

Allows navigation to the beginning of the list or one screen at a time to the

left.

Allows navigation one screen at a time or to the end of the list to the right.

Allows alphabetical sorting of items from A-Z and Z-A.

Allows you to clear search field entries or sorting.

 

Allows you to enter free text if the selection you require is not shown.
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Siren’s robust search tool also lets you search for items by entering text. Typing [ BR ] in the

search field yields the following results.

Buttons beginning with the entered text are listed first, followed by buttons containing the

search criteria.
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5.4.2 Pick List Button States

Siren Field User buttons have multiple states in order to document different types of data.

In the screenshot below the major three states are displayed: Unselected, Selected, and

Pertinent Negative.

Unselected buttons appear raised and grey, indicating that the data

has not been entered for the ePCR.

Pressing the button once causes it to appear in its selected state:

pressed down and green, indicates that the data has been recorded.

Pressing the button twice causes it to be in the pertinent negative

state: pressed down and orange with a line through the text, indicates

that the item was checked and determined not to be present. Pressing

the button once more returns it to the unselected state.

 

Note: Not all buttons can be pertinent negative. Depending on the type of information being

documented, it might not be logical for them to be pertinent negative. 
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5.4.3 Adding Additional Details

Some pick list options can accept additional details. This allows you to document more

information.

The following icons will be displayed if the Pick List option can accept additional details:

Indicates additional details can be accepted. To do this, long-press the pick list

item.

Indicates additional data is present.
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5.5 Summary Pick Lists

Some sections use Summary Pick Lists that permit entering data via pick lists as well as

viewing a summary of previously entered information. The image below shows a large pick

list in Assess/Plan > Exams. Items (buttons) that are selected are added to the Summary

Table below the pick list, along with any details associated with that button.
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5.5.1 Using the Pick Lists Summary Tables

The Summary Pick List contains a Summary Table at the bottom of the screen. This table

displays a list of the selected buttons as well as a summary of details entered via the form

associated with each button.  For example, selecting Oxygen Therapy in the Assess/Plan

section will create a row for that item in summary table. 

The summary table toolbar displays different buttons depending on the type of

information being captured. 

Common buttons include the following:

Edit

Edit or add the details of the highlighted item.

SARC

Use to enter if procedure was successful, attempts, reasons, response, and any

complications.

Authorization

Use to document who authorized the procedure. 

Delete

Highlight the row and select this button to delete the row and all of its details.

Copy

Highlight the row and select this button to copy and paste the row.

New Same Type

Highlight the row and select this button to copy and paste only the type.

Reason For Not Entering

Use to document why information was not entered.  
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5.6 Long Caption Pick List Control

Areas requiring long labels are outfitted with Long Caption Pick Lists. This is a new control

used to capture medications, allergies, medical/surgical history.
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To use a Long Caption Pick List:

Step 1: Select an item by using the navigation tolls. Or use Siren’s robust search tool

by typing text. 

Typing [ TYLE ] in the search field yields the following results shown below.  

Step 2: Click OK. 

Step 3: To enter additional comments, dosage, frequency etc. Click on the item in

the summary table to highlight it, then select  .

Step 4: Enter any addition information and click OK. 
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Adding items not Included in the Long Caption Pick List

Items not found in the Long Caption Pick List can be entered manually. 

To manually enter an item:

Step 1: At the top of the Long Caption Pick List, Type the item you would like to

add. 

Step 2: If it does not appear in the list click  ADD button.

Step 3: Click OK.

Note: The ADD function is only available in select Long Caption Pick Lists.  

Removing Items From the Summary List 

If an item is accidentally entered, it can be deleted from the list.

To remove an item from the Summary List:

Step 1: In the Summary List, Select the appropriate row to highlight the item you

would like removed.

Step 2: Click the  DELETE icon.

Step 3: Click YES to the confirmation message.
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5.7 Magnetic Swipe Card, Bar Code Reader, & QR Code Reader

Data can automatically be captured from swipe cards, barcodes, and QR codes. The

software can be configured to allow the import of information such as a driver’s license #,

health card #, ID card #, etc. Siren’s Card Reader also supports the capturing of date

formatted fields.

Discrepancies are noted on the Verify Transfer screen after the card has been scanned. In

the example above, you must choose the First Name and Last Name.
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5.8 Computer Aided Dispatch (CAD)

Siren Field User allows the import of CAD information from a third party source to over 150

fields in the ePCR.  

There are two ways to import CAD information into Siren.  You can manually request the

data by simply keying in an incident number, or have it automatically downloaded to the

tablet via a mechanism we refer to as CAD Push. Siren is able to determine which tablet to

send the information by a simple check of the unit number.

In order to receive CAD information, the communication lights must be green as this

information comes via the server.  
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5.8.1 CAD Push

When using the CAD Push method, you must be logged on.  You can be at any screen within

Siren there is no fixed position required.  A call will automatically appear on your tablet

advising you of the call.  

See screenshot below:

To accept the CAD data click OK. You will be prompted to either apply this information to

an existing call or to a  new one.  It is possible to create a new ePCR and start documenting

a call before the CAD is downloaded.  In this case you would choose the option to apply to

an existing ePCR.  If there has not been a call created, select the option Apply New ePCR.
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5.8.2 CAD List Buttons

Show All/Show Unused

By default the CAD List screen only shows CAD calls that have not been applied to an ePCR.

 Select Show All to see all the CAD calls that were sent to that particular tablet during the

shift.  Select Show Unused to toggle back to only showing CAD calls that have not been

applied to an ePCR.

Apply – Existing PCR 

To select a particular ePCR to which the CAD information will be applied.

Apply – New PCR 

To create a new ePCR and automatically apply the CAD information to that ePCR.

Cancel 

Press Cancel to close the dialog without applying the CAD information.  The corresponding

CAD call will not be lost.  You may manually return to the CAD List screen via the Menu or

CAD Icon in the Information Bar. 
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5.8.3 CAD Pull

CAD information can be explicitly requested (pulled) by simply entering an incident

number.  At that point the system sends a message to the server requesting any CAD

information that is related to that unit number and incident number.  When information is

available you will receive the following notification, indicating the CAD data has been

applied.

5.8.4 CAD Reconciliation

If any of the data from CAD conflicts with manually entered ePCR data, the field will be

flagged as a conflict.  You will be notified of conflicts via the CAD Circle within the

Information Bar. 

It identifies the number of conflicts.

Tapping on the CAD Circle will take you to the CAD Reconciliation screen where you can

view the conflict(s) and decide whether to use the CAD value or the ePCR value.  
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Once a field is reconciled to accept CAD data, it will automatically receive all CAD updates.

You will see which fields are subsequently CAD updated by revisiting the CAD

Reconciliation screen and looking at the rows marked with a blue information icon (e.g.

Destination Type above was updated by CAD to be Hospital since the last time you viewed

the CAD Reconciliation screen).  Conflicts are marked in red and have an error icon.
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5.9 Transmitting Defibrillator/Monitor Data

Data captured on a defibrillator/monitor can be imported and integrated with open ePCRs.

The data can be imported into the ePCR at any time before it is finalized. 

Data transmission methods from the defibrillator/monitor to the computer running the

Siren application is determined by each defibrillator/monitor manufacturer. Common data

transfer methods include serial cable direct, Serial-to-USB adapter, Bluetooth and Wi-Fi

connections. 

You must have the appropriate equipment/technology to support the recommended data

transmission method in addition to a defibrillator/monitor enabled and configured to

support the same. 

Ensure that the defibrillator is configured for the method of data transmission you plan to

use. As each defibrillator/monitor has different steps to transmit data, please refer to the

following operating instructions for your use. 

Siren Field User integrates with several defibrillator/monitors:

Physio Control LIFEPAK® 12 

Physio Control LIFEPAK® 15 

ZOLL M Series ®

ZOLL E Series ®

ZOLL X Series ®

Philips HeartStart MRx 

corpuls  3

*Click link above or proceed to page number listed for more information. 
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Data transmission methods from the defibrillator/monitor to the computer running the

Siren application is determined by each defibrillator/monitor manufacturer. Common data

transfer methods serial cable, Serial-to-USB adapter, Bluetooth and Wi-Fi connections.

Import and software details for specific vendors is below.

Defibrillator
Vendor 

Model Vendor Software Supported Transfer Types
Supported 

ZOLL M Series®
E Series®
X Series®

Version 5.8 Zoll API
Microsoft Bluetooth Stack (M and E

Series®) 

Wired with serial
cable or serial to USB
adapter
Bluetooth (M and E

Series®)
Wifi (X Series®
only)

Physio-Control LIFEPAK® 12
LIFEPAK® 15

CODE-STAT 9.0.2 API
Microsoft Bluetooth Stack 

Wired with serial
cable
Bluetooth 

Philips Philips HeartStart
MRx

Phips HeartStartData SDK 3.5
Non-Microsoft Bluetooth stack
supporting FTP Data Exchange (such
as Toshiba) 

Bluetooth

GS Elektomed corpuls3 Corpuls Data Interface Libraries  Bluetooth 
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5.9.1 Transmitting from a LIFEPAK 12® or LIFEPAK® 15 Defibrillator/Monitor

Siren Field User contains an ECG/Monitor interface that integrates with the LIFEPAK® 12

and 15 Defibrillator/Monitor series device. The LIFEPAK 12 and 15 Defibrillator/Monitor is

connected to the tablet PC with a serial cable or with wireless Bluetooth technology.

Information that can be imported into an open ePCR includes: patient vital signs,

procedures, and medications recorded as LIFEPAK events, LIFEPAK reports, and LIFEPAK

ECG waveforms. 

ECG waveforms are viewable in Siren Field User as individual snapshots of the ECG

waveform or the entire animated waveform (via a defibrillator / monitor specific viewer).

Waveforms are also viewed or printed from the ECG Manager. All imported ECG

information is viewed via the ECG Manager whether or not the corresponding event or

report is attached to the ePCR.

To transmit LIFEPAK Defibrillator/Monitor information to the tablet PC:

Step 1: Create a new ePCR in Siren Field User or open an existing ePCR.

Step 2: Ensure that a connection is established between the defibrillator/monitor to

the tablet.

Step 3: On the defibrillator, click the TRANSMIT button.

Step 4: Use the speed dial to select DATA, and then press the knob.

Step 5: Use the speed dial to select ALL REPORTS, and then press the knob.

Step 6: Use the speed dial to select a SITE, and then press the knob.

Step 7: Use the speed dial to select SEND, and then press the knob. 
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5.9.2 Transmitting from a ZOLL M Series®, E Series® & X Series®
Defibrillator/Monitor

Siren Field User contains an ECG/Monitor interface that integrates with the ZOLL M Series®,

E Series®, and X Series® devices. Data captured on the defibrillator can be imported and

integrated with open ePCRs. 

The ZOLL M Series®, E Series® and X Series® is connected to a tablet PC with a serial

cable, serial-to-USB, wireless Bluetooth technology (M and E-Series), and Wifi (X-Series

only).

ECG waveforms are viewable from within Siren Field User. ECG waveforms are attached to

an ePCR so that they print from Siren Field User with the ePCR. Waveforms are also viewed

or printed from the ECG Manager. All imported ECG information is viewed via the ECG

Manager whether or not the corresponding event or report is attached to the ePCR.

To transmit ZOLL M and E Series® Defibrillator/Monitor information to the tablet PC:

Step 1: Create a new ePCR in Siren Field User or open an existing ePCR.

Step 2: Turn off the ZOLL M Series® or E Series® defibrillator.

Step 3: Wait 30 seconds.

Step 4: Hold the leftmost button on the ZOLL M Series® or E Series® unit and turn

the unit on.

Step 5: Select UPLOAD CARD.

Step 6: Select SEND.

Step 7: On the SOAP bar of Siren Field User, click Vitals. 

Step 8: On the submenu, click ECG/MONITOR.

Step 9: Select DOWNLOAD ZOLL DATA/RETRIEVE MONITOR DATA.

Note: Depending on the Siren configuration, this caption may be slightly different. 

Step 10: Under the Read From Serial/Bluetooth section, if different from the default,

enter the COM port number used by the tablet in the COM Port field.
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Note: Check the Bluetooth COM ports by double clicking the Bluetooth icon in the task bar.

Select the COM Ports tab, this is marked 'Serial Port'. In the example below, the COM port is

25.
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Step 11: Click RETRIEVE DATA.

The information is transmitted to the tablet PC.
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To transmit ZOLL X Series® defibrillator information to the tablet PC using Wifi:

Step 1: Create a new ePCR in Siren Field User or open an existing ePCR.

Step 2: On the SOAP bar, click VITALS.

Step 3: From the ECG/Monitor submenu, click PATIENT LIST.

Step 4: Select DOWNLOAD ZOLL DATA/RETRIEVE MONITOR DATA on the bottom

right hand side. 

Note: Depending on the Siren configuration, this caption may be slightly different. 

The following screen will appear.

Step 5: If the ZOLL device is not listed, Select REFRESH . 

Step 6: Choose ZOLL X SERIES CASE WEB SERVICE, then click EDIT .
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The following screen will appear.

Step 7: Choose the case you want to import, then click OK. 

The case will load into Siren and be ready for importing into the ePCR.

Depending on the size of the file, you may see the file parsing, wait until it is complete. 

Step 8: Select IMPORT CASE. 
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To transmit ZOLL X Series defibrillator information to the tablet PC using USB:

Step 1: Insert the USB in the USB port on the left hand side on the Zoll monitor. 

Step 2: Press LOG.

Step 3: Press USB.

Step 4: Select the case you wish to transfer. 

When the case is transferred onto the USB the monitor will display "Transfer

is complete".

Step 5: Remove the USB and click OK on the monitor.

Step 6: Insert the USB into the tablet. 

Step 7: Create a new ePCR in Siren Field User or open an existing ePCR.

Step 8: On the SOAP bar, click VITALS.

Step 9: On the Side Navigation Control, click ECG/MONITOR.

Step 10: From the ECG/Monitor submenu, click PATIENT LIST.

Step 11: Click DOWNLOAD ZOLL DATA/RETRIEVE MONITOR DATA on the bottom

right hand side. 

Note: Depending on the Siren configuration, this caption may be slightly different. 

A pop up screen will appear. 

Step 12: Click BROWSE for the card file. 

Step 13: Select the correct .json file (verify date and time). 

Step 14: Click OPEN.

A message will appear "Zoll data successful".

Step 15: Click OK.
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5.9.3 Transmitting from a Philips HeartStart MRx  Defibrillator/Monitor

Siren Field User contains an ECG/Monitor interface that integrates with the Philips

HeartStart MRx Defibrillator/Monitor. Data captured on the defibrillator can be imported

into an ePCR. 

The Philips HeartStart MRx is connected to a tablet using wireless Bluetooth technology. If

Philips Bluetooth is configured (ie. Toshiba Stack), then Bluetooth Transfers in Siren (ie.

Windows Stack) are unavailable.  

ECG waveforms are viewable from within Siren Field User. ECG waveforms are attached to

an ePCR so that they print from Siren Field User with the final ePCR. Waveforms are also

viewed or printed from the ECG Manager. All imported ECG information is viewed via the

ECG Manager whether or not the corresponding event or report is attached to the ePCR.

To transmit Philips HeartStart MRx Defibrillator/Monitor information:

Step 1: Create a new ePCR in Siren Field User or open an existing ePCR.

Step 2: Press the MENU SELECT button on the Philips HeartStart MRx.

Step 3: Using the Navigation buttons, select OTHER and press MENU SELECT.

Step 4: Select DATA MANAGEMENT and press MENU SELECT.

Step 5: Press MENU SELECT to acknowledge the message Leaving Normal

Operational Mode.

Step 6: Use the [PREV ITEM] and [NEXT ITEM] soft keys to select an EVENT

SUMMARY.

Step 7: Press MENU SELECT to display the Data Management menu.

Step 8: Select SEND and press MENU SELECT.
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5.9.4 Transmitting from a corpuls3 Defibrillator/Monitor

Siren Field User contains an ECG/Monitor interface that integrates with the Defibrillator.

Data captured on the defibrillator can be imported into an ePCR. 

Siren connects to corpuls3 using a non-discoverable Bluetooth connection. 

corpuls3 cases are not downloaded, Siren Field User must have an active connection to the

corpuls3 Defibrillator/Monitor in order to access patient case data. Corpuls does not make

the full ECG strip available to external applications. Only snapshots of the 12 lead ECG

(called a D-ECG) are available. 

Electronic Therapy is the only Siren procedure that is dynamically added to the ePCR based

upon defibrillator data.  

To retrieve Defibrillator/Monitor information into an ePCR:

Step 1: Create a new ePCR in Siren Field User or open an existing ePCR.

Step 2: On the SOAP bar, click VITALS.

Step 3: On the Side Navigation Control, click ECG / MONITOR.

Step 4: Click PATIENT LIST (if not already selected).

Step 5: Click RETRIEVE MONITOR DATA. 

The Read from Non-Discoverable Bluetooth Device screen will appear.

Step 6: Click DEVICE NAME.

Step 7: Select the group and device name from the list. 
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Step 8: Click OK.

Predefined device information will auto-populate the required entries for the

device.

Step 9: (Optional): Click TEST CONNECTION. 

This will indicate whether the tablet can successfully connect to the corpuls3 device from the

data entered. 

Step 10: Click RETRIEVE DATA.
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Note: In the event the corpuls3 device is not preconfigured within Siren, the following

information needs to be manually entered for each field:

Device Name Pick List  containing pre-configured devices (can be configured with

MAC Address and PIN). 

DEVICE NAME will not appear if no picklist items are configured. 

MAC Address Free Text  required to enter MAC Address of the corpuls3 device, found

on the corpuls3 Defibrillator/Monitor.

 

PIN Free Text  required to enter the security PIN of the corpuls3 device, found

on the corpuls3 Defibrillator/Monitor.

COM Port Numeric field  required to enter the COM Port of the tablet will use to

connect to the corpuls3 device. Default value is what is entered in the client

configuration. 

Number of

Cases

Numeric field   required to indicate the number of corpuls3 cases that

will appear in the Patient List. 

This will save all the data entered and refreshes Patient List with corpuls3 cases. 

37
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Step 11: Select the desired corpuls3 cases and click  IMPORT CASE. 

Once the case is imported, the status details will be listed in the Status

column. 

Vital signs included in the case will be listed in the Vital Signs section. 
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To setup corpuls3:

Step 1: On the the main menu of the corpuls3 Defibrillator/Monitor, select

BLUETOOTH. 

Step 2: Select SETTINGS. 
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Step 3: Select the desired settings. 

MAC Address The MAC address is the hardware address of the Bluetooth module and

serves as identification of the device in a network. The MAC address cannot

be changed. 

 

PIN  The PIN is an associated number that associates one Bluetooth enabled

device with another. 

Note: The MAC Address and PIN values presented on this screen are used in the

preconfiguration of this device within the list of available devices in Siren. 

If the device is not preconfigured, the values provided here are required for manual entry when

connecting Siren to corpuls3. 
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5.10 ePCR Transfers

The Transfer function allows System Users to move an unfinalized ePCR to another System

User’s tablet. Transfers can also be performed from the server to a tablet in order to allow

medics to make corrections or updates. Below is a description of the various transfer

options offered by Siren ePCR Suite.

5.10.1 Tablet-To-Tablet Transfers (Transfer Control)

The Tablet-to-Tablet transfer feature allows an unfinalized ePCR to be created on one

tablet and transferred to another tablet where it can continue to be logged and finalized.

The Tablet-to-Tablet transfer can be completed using a connection to the server or using

Bluetooth technology. Successful Bluetooth transfers require both tablets to have Bluetooth

enabled, be in proximity to each other, and have the same version of Siren software

installed. 

A Tablet-to-Tablet transfer is useful when an initial unit arrives at the scene and opens an

ePCR that is later completed by a secondary emergency medical services unit.
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A Tablet-to-Tablet transfer is performed by doing the following:

Note: A transfer cannot be completed if the ePCR has not been assigned an Incident Number. 

Step 1: Select the appropriate ePCR on the Patient List screen.

Step 2: Click the  icon on the Patient List screen.

A Transfer Method Screen will appear. 

Step 3: Select Via Bluetooth or via Server. 
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Note: When performing a Bluetooth transfer, you must provide the receiver with the PIN you

assign to the transfer.

A transfer ePCR screen will appear. 

Step 4: Complete the fields pertaining to the sender, target recipient, and the reason

for the transfer. 

Step 5: Click OK. 

5.10.2 Accepting Transfers

ePCR Transfer is used to send ePCRs from either a back office person to a tablet or from

another field user, so the recipient can make edits and additions to the patient information.

When a request for ePCR Transfer is received by a user, the transfer must be accepted

before the ePCR can be modified.  If the ePCR had been transferred from a back office

person (via the Siren Web Administration application), there may be associated comments

from the sender.  These can be accessed via the View Comments toolbar button on the

Patient List screen.



Siren ePCR User Manual72

Copyright © 2016 Medusa Medical Technologies, Inc.  

6 Principle Application Sections

Although the names of Siren Field User's SOAP buttons may vary depending on

configuration requirements, the major sections are listed below. 

Incident

Incident details including date and time, location, and destination. 

Patient ID 

Enter basic patient information including name, age, weight, demographic data, contact

information, billing information, and necessity of service.  It also contains the patient

lookup section which allows the retrieval of patient history.

ABCD

This section includes the Primary Survey which includes airway, breathing, circulation, C-

Spine, Bleeding, disability, and initial patient acuity, as well as scene findings and barriers

to patient care.

History

Enter information about the patient's history, including chief complaint and secondary

complaint, symptoms,  medications, allergies, past medical history, social and family

history. It also includes the trauma section with causes of injury and mechanism. 

Vitals 

Vitals information such as heart rate, blood pressure, respiratory rate, CO2, SpO2, and

temperature, as well as scores (e.g. CTAS, GCS, MEWS), triage, APGAR, ECG readings, and

ECG interpretations on imported defibrillator events.

Lab Values 

Advanced diagnostic information such as electrolytes, hematology, cardiac markers,

coagulation and blood gases. It also allows entry of results of imaging technology such as

CT, MRI, PET, Ultrasound, X-Ray, and Angiography.

Assess/Plan 

Exams, procedures, protocols, and view a summary. This section also displays mannequins

(based on the patient's age and sex) with front, back, left, and right side views. Mannequins

allow multi-body part selection and can display injury / observation selections in callouts,

with a line to the associated body part.
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Outcomes

Capture patient outcome information such as whether the patient was treated and/or

transported, cardiac arrest details, and whether stroke / CVA systems were resolved. This

section also permits documenting the supplies used during the call, as well as reference

materials associated with the ePCR. 

Care Plan 

Document primary impressions and secondary impressions, the patient's care plan, advice

provided to the patient and caregiver, and concerns regarding the patient. Additionally,

capture information pertaining to referrals and encounters in which the EMS crew

discharges the patient outside of the hospital setting.  

Review 

View the ePCR report, as well as print or fax, view a list of required fields not yet

completed, sign the report, and finalize the ePCR. 



Siren ePCR User Manual74

Copyright © 2016 Medusa Medical Technologies, Inc.  

6.1 Incident

The Incident button in the SOAP bar is used to document information about the incident.

The Side Navigation Control has the following options: vehicle/crew, Incident,

Times/Details, and Incident outcomes.  Further selections in the submenu include: Dispatch

Information, Location.

The different types of  data entry in this section include:

Numeric fields

Date/Time fields

Free Text

Pick List

Computer Aided Dispatch (CAD)

*Click link above or proceed to page number listed for more information. 
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6.2 Patient Identification

The Patient ID button in the SOAP bar is used to document the patient's demographic,

contact, and insurance information. Selecting the Patient ID button will display the Side

Navigation Control with submenus for Identification, Billing Information, and Patient

Lookup. Further selections in the submenu reveal a list of related subcategories. For

example, selecting Identification reveals the following subcategories: Personal,

Demographics, and Contacts.

The different types of data entry in this section include:

Numeric fields

Date/Time fields

Free Text

Pick List

Magnetic Swipe Card, Bar Code Reader & QR Code Reader

*Click link above or proceed to page number listed for more information. 
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Entering Patient ID Information

To enter information in Patient ID:

Step 1: On the SOAP bar, click PATIENT ID.

Step 2: Select an item from the Side Navigation Control.

Step 3: Select a button or field and use the form data entry tools to document

information.

Copying Patient ID Information

Information can be copied between sections in Patient ID. For example, you can copy

address and contact information from one section to another without re-typing it. You can

also copy the incident location linked from CAD into PATIENT ID > Identification

>Demographics.

To copy Incident Location information to PATIENT ID > Identification >

Demographics:

Step 1: On the SOAP bar, click PATIENT ID.

Step 2: Select IDENTIFICATION from the Side Navigation Control.

Step 3: Select DEMOGRAPHICS from the submenu.

Step 4: Click COPY INCIDENT LOCATION.
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6.2.1 Patient Lookup

The Siren Server Patient Lookup function allows you to retrieve past ePCRs for a specific

patient and copy relevant information into a new ePCR. Information includes medications,

allergies, responsible party, contacts, insurance, past medical history, etc. For consistency

and data integrity, the Patient Lookup function only retrieves finalized reports. Depending

on configuration, this function will retrieve a maximum of six of the most recent finalized

ePCRs for a particular patient.
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The following patient information is required to use Patient Lookup: 

· There must be communication between the tablet and server as the information pulled

back resides on the server.

· Required fields are noted in red and must be completed in order to retrieve results.

Depending on configuration, the following fields can also be used as search criteria:

· Last Name

· First Name

· Sex

· Postal or Zip Code

· Social Security/ Insurance Number 

· Provincial Health Card No.

· Driver’s License Number

· Telephone Number

· Date of Birth

Once search criteria have been entered, the request is sent to the server. Records matching

that criteria are returned to the tablet, allowing you to copy the following information to a

new ePCR:

· Personal and Demographic

· Patient Contacts

· Responsible Party

· Insurance

· Employer's Information

· Past Medical History

· Medications 

· Allergies

Pick list items in white have information that can be imported into the new ePCR. The white

fields change to green after selection to indicate that they will be imported into the current

ePCR.  

If a pick list item is disabled (appears greyed-out), this indicates the selected ePCR does

not contain that type of information (e.g. no patient medications have been recorded in

that ePCR). 
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An example of the Patient Lookup Results.
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6.3 ABCD

The ABCD button is used to document information collected from the Primary Survey and

Scene Findings. Primary Survey includes: Airway, C-S-Spine, Breathing, Circulation, Bleeding,

Disability, and Initial Patient Acuity. Scene Findings include: Barriers to Patient Care,

Emergency Info Form, Alcohol or Drug use Indicators, Location Patient Found, and other

Scene Findings.  

The different types of data entry in this section include:

Numeric fields

Date/Time fields

Free Text

Pick List

Summary Pick Lists

Long Caption Pick List

*Click link above or proceed to page number listed for more information. 
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6.4 History

The History button in the SOAP bar is used to document information in regards to the

patient's complaints, allergies, medications and past medical history. 

Entering History Information

The different types of data entry in this section include:

Numeric fields

Date/Time fields

Free Text

Pick List

Summary Pick Lists

Long Caption Pick List

*Click link above or proceed to page number listed for more information. 
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To Document No Known Allergies or No Allergies Entered:

Step 1: Above the Summary Table, click .

The following box will appear. 

Step 2: Choose an option. 
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6.5 Vitals

The Vitals section is where all patient vital signs, scores, and ECG / Monitor information are

documented throughout the patient’s treatment. Selecting the VITALS button from the

SOAP Bar opens the Vitals screen displaying a Side Navigation Control with subcategories:

Vital Signs, Scores, and ECG / Monitor buttons. Expanding these submenu topics reveals

related subcategories. For example, selecting ECG / Monitor reveals the following

subcategories: Patient List, Imported Patients, Events, Reports, and ECG Interpretation. Data

can be entered into each applicable subcategory to fully document the patient’s vital signs. 

The different types of data entry in this section include:

Numeric fields

Date/Time fields

Free Text

Pick Lists

ECG & Monitor - Universal Defibrillator/Monitor Interface

*Click link above or proceed to page number listed for more information. 
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6.5.1 Vital Signs

This section includes Heart Rate, Respiratory Rate, Systolic Blood Pressure (BP Systolic),

Diastolic Blood Pressure (BP Diastolic), and other related fields. 

Adding a Vital Set

Step 1: On the SOAP bar, click VITALS

Step 2: Click VITAL SIGNS on the Side Navigation Control. 

The Vitals Summary Table will appear and show all the Vital Sign entries

added to the ePCR. If no data exists, the table will be blank.

Step 3: Click  ADD to create a new vital set. 

The Vital Signs screen will appear. 
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Step 4: Enter the vital sign information. 

Note: Date/Time must be recorded for each vital set. This field automatically populates with

the current date/time. If this is not desirable, you may use the   control to assign

specific date/times. 

Step 5: Click SAVE.

Note: If the number of items exceeds the screen area, you can press the up and down arrows at

the bottom of the screen to scroll through the complete list. 

Editing a Vital Set:

Step 1: On the SOAP bar, click VITALS.

Step 2: On the Side Navigation Control, click VITAL SIGNS.

Step 3: In the Summary Table, either click the appropriate vital set and Click the

EDIT button or double tap the desired vital set.

The Vitals Set screen will expand allowing the appropriate field to be edited.

 

Step 4: Click Save.

Deleting a Vital Set:

Step 1: On the SOAP bar, click VITALS.

Step 2: On the Side Navigation Control, click VITAL SIGNS.

Step 3: In the Summary Table, click the appropriate vital set in order to highlight the

row.

Step 4: Click the  DELETE button.  

Step 5: Click YES to the confirmation message.  
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The Visual Pain Score can be used to document pain visually and is available within the

Vital Signs screen.   

To document a pain score with a visual:

Step 1: On the SOAP bar, click VITALS.

Step 2: On the Side Navigation Control, click VITAL SIGNS.

Step 3: Under PAIN: WONG-BAKER (Faces) click 

The Visual Pain screen will appear (as shown above). 

Step 4: Select the visual pain score from the available list. 
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6.5.1.1 Editing & Deleting Vital Signs from an Imported Vitals set

Imported vitals sets can be edited or deleted. 

To delete vitals information:

Step 1: On the SOAP bar, click VITALS.

Step 2: On the Side Navigation Control, click VITAL SIGNS.

Step 3: Select the vital signs set that you wish to delete.

Step 4: Click the   button.

Step 5: Click YES in the confirmation message. The vitals set will be deleted.

To edit a vitals set:

Step 1: On the SOAP bar, click VITALS.

Step 2: On the Side Navigation Control, click VITAL SIGNS.

Step 3: Select a vital signs set to change. The entry is highlighted.

Step 4: Click the   button.

Step 5: Update the information using the form data entry tools.

Step 6: Click SAVE.

This vitals set will be updated and the vitals set will then indicate that a manually entered

set has been entered as opposed to one downloaded from the defibrillator.  From that

point forward, the vitals will be treated as if they were manually entered. 
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6.5.2 Scores

Use the Scores button to document any scores relating to the patient’s condition. Scores

that can be documented in the tab include: Revised Trauma Score, Rapid Triage, Broselow

Tape Category, % Burn, APGAR (Appearance, Pulse, Grimace, and Respiration for

newborns), and Acuity. 

Adding a Score Set

To enter a score:

Step 1: On the SOAP bar, click VITALS.

Step 2: From the Side Navigation Control, click SCORES

The screen displays the Scores Summary Table which lists the score sets already added to

the ePCR (this section will be blank if nothing has been added yet).

Step 3: To add a score set, click the add  icon.    

Step 4: Enter or select score information. 

Step 5: Click Save. 

Note: If the number of items exceeds the screen area, you can press the up and down arrows at

the bottom of the screen to scroll through the complete list. 

Editing a score set:

Step 1: On the SOAP bar, click VITALS.

Step 2: From the Side Navigation Control, click SCORES

The screen displays the Scores Summary Table which lists the score sets

already added to the ePCR.

Step 3: To edit a score information, highlight the appropriate row in the summary

table. 

Step 4: Click the  EDIT button.   

Step 5: Enter or select information to be edited. 

Step 6: Click SAVE. 
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Deleting a score set:

Step 1: On the SOAP bar, click VITALS.

Step 2: From the Side Navigation Control, click SCORES

The screen displays the Scores Summary Table which lists the score sets

already added to the ePCR.

Step 3: Highlight the appropriate row in the summary table. 

Step 4: Select the   DELETE button.   

Step 5: Click YES to the confirmation message. 
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6.5.3 ECG/Monitor

The ECG/Monitor section is used to transmit, import, and attach defibrillator/monitor

information including waveforms to an ePCR. This section includes:

Patient List 

A list of patient information downloaded from the defibrillator/monitor to the tablet.

Imported Patients 

A list of defibrillator/monitor patients imported into the current ePCR.

Events

A list of events sent by the defibrillator/monitor. This section also allows you to open a

screen to view specific waveforms related to events/reports.

Reports 

A list of reports that can be attached to the ePCR. This section also allows you to open a

screen to view specific waveforms related to events/reports.

ECG Interpretation 

Used to record additional information regarding a particular event or report from the

defibrillator/monitor.

Data captured on a defibrillator/monitor can be imported and integrated with open ePCRs.

Defibrillator data can be imported into the ePCR at any time before it is finalized. Siren

Field User integrates with several defibrillators/monitors. 

Click the links below or proceed to the page number listed for transmission

instructions:

Physio Control LIFEPAK® 12 

Physio Control LIFEPAK® 15 

ZOLL M Series®

ZOLL E Series®

ZOLL X Series®

Philips HeartStart MRx 

corpuls 3  Defibrillator 
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6.5.3.1 Importing Defibrillator/Monitor Data

After the defibrillator/monitor information is transmitted to the tablet, the information can

be imported to ePCRs. 

To import Defibrillator/Monitor information into an ePCR:

Step 1 On the SOAP bar, click VITALS.

Step 2: On the Side Navigation Control, click ECG / MONITOR.

Step 3: Click PATIENT LIST (if not already selected).

Step 4: In the Data Entry Pane, click the patient information needed for import to the

current ePCR. 

Note: Lists can be re-ordered by clicking on the column headings. 

Step 5: Click the   button.  A progress bar is displayed while the information is

imported.

Note: Vital signs are added to the Vital Signs table, and procedures and medications are added

to the Assess / Plan section of the ePCR.

Import is now complete. The status column updates after import to indicate which ePCR the

defibrillator / monitor information has been imported. 
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6.5.3.2 Viewing and Adding Defibrillator/Monitor Data

To view ECG information imported from a defibrillator/monitor:

Step 1 On the SOAP bar, click VITALS.

Step 2: On the Side Navigation Control, click ECG / MONITOR.

Step 3: Click PATIENT LIST (if not already selected).

The Source column notes which defibrillator / monitor imported the ECG information. If

associated vendor software is installed, you can view any ECG data associated with an

ePCR.
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6.5.3.3 Re-Importing a Patient

Re-importing a patient case permits you to overwrite previously imported data.

To re-import a patient case into an ePCR:

Step 1: On the SOAP bar, click VITALS.

Step 2: On the Side Navigation Control, click ECG/MONITOR.

Step 3: From the ECG/Monitor submenu, click PATIENT LIST.

Step 4: In the Data Entry Pane, click the patient case you want to re-import into the

current ePCR.

Step 5: Click the   button. 
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The Import Options screen will appear.

Step 6:  Click the Re-import button.

The file is re-imported and previous defibrillator/monitor data is deleted from the ePCR.

6.5.3.4 Merging/Appending Defibrillator/Monitor Files

You can merge LIFEPAK records or add additional defibrillator/monitor files within one

ePCR. For example, you can import a ZOLL patient and a LIFEPAK 12 or 15 patient into the

same ePCR. Only LIFEPAK 12 and 15 patients can be merged.

To merge two files within one ePCR:

Step 1: On the SOAP bar, click VITALS.

Step 2: On the Side Navigation Control, click ECG / MONITOR.

Step 3: From the ECG / Monitor submenu, click PATIENT LIST (if not already

selected).
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Step 4:  In the Data Entry Pane, click the patient case you want to import into the

current ePCR.

Step 5: Click the   button. The first patient case is imported.

Step 6: In the Data Entry Pane, click the second patient case you want to merge /

append to the current ePCR.

Step 7: Click the button. 

Step 8: Click the Merge / Append button. 
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If attempting to merge two LIFEPAK cases, the Case Merge Wizard will display:

Step 9: Click NEXT In the Case Merge wizard.

Step 10: Choose which data to keep.
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Step 11:  Click NEXT. 

The two LIFEPAK files are merged into a new patient case.

Step 12: Click FINISH.

The new patient case is imported into the ePCR.
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6.5.3.5 ECG Events and Reports

Once a defibrillator/monitor case is imported into an ePCR, you can review events/reports

associated with that case. 

To view events and reports:

Step 1: On the SOAP bar, click VITALS.

Step 2: On the Side Navigation Control, click ECG/MONITOR.

Step 3: From the submenu, click EVENTS or REPORTS. 

6.5.3.6 Viewing Waveforms

Once a defibrillator/monitor case is imported into an ePCR, the you can attach waveforms

to the ePCR. Attached waveforms can be printed and are also listed at the end of the ePCR. 

Note: All ECG reports can be viewed via the ECG Manager. 

Attaching Waveforms on an ePCR:

Step 1: On the SOAP bar, click VITALS.

Step 2: On the Side Navigation Control, click ECG/Monitor.

Step 3: From the submenu, click Events or Reports, then select View Reports.
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A Report screen opens allowing the you to select the reports that will be attached to the

ePCR.
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6.5.3.7 ECG Interpretation

This section is used to manually key-in the clinician’s interpretation of the ECG. 

Adding ECG Interpretations:

Step 1: On the SOAP bar, click VITALS.

Step 2: On the Side Navigation Control, click ECG/Monitor.

Step 3: From the submenu, click ECG Interpretation.

The ECG Interpretation Summary Table displays the sets already added to the ePCR. The

section will appear blank if no data has been entered.

Step 4: Click the  ADD button to add enter an interpretation.

Step 5: Click SAVE.

Editing ECG Interpretations:

Step 1: On the SOAP bar, click VITALS.

Step 2: On the Side Navigation Control, click ECG/MONITOR.

Step 3: From the submenu, click ECG Interpretation.
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Step 4: Select the interpretation you want to edit, and then click the  button.

A popup appears displaying the details of the selected interpretation. 

Step 5: Use the form data entry tools to enter information.

Step 6: Click SAVE to save the information. 

Deleting ECG Interpretations:

Step 1: On the SOAP bar, click VITALS.

Step 2: On the Side Navigation Control, click ECG/MONITOR.

Step 3: From the submenu, click ECG Interpretation.
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Step 4: Select the appropriate interpretation in the Summary Table and click the

  button.

Step 5: Click YES to the confirmation message.
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6.6 Lab Values

The Lab Values section allows you to enter advanced diagnostic information such as

electrolytes, hematology, cardiac markers, coagulation and blood gases. It also allows entry

of results of imaging technology such as CT, MRI, PET, Ultrasound, X-Ray, and Angiography.

The different types of data entry in this section include:

Numeric fields

Date/Time fields

Free Text

Pick List

Summary Pick Lists

*Click link above or proceed to page number listed for more information. 

6.6.1 Diagnostics

Siren Field User allows you to attach diagnostic results to the ePCR.

To attach a diagnostic file to an ePCR:

Step 1: On the SOAP bar, click LAB VALUES.
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Step 2: From the Side Navigation Control, click DIAGNOSTICS.

Step 3: Select the type of diagnostic from the pick list. 

Step 4: Select the appropriate Diagnostic from the Summary Table.

The following screen will appear.

Step 5: Click the  ADD button. 

Your computer's Browse screen will appear. 

Step 6: Find the location of the File and Select it. 

Step 7: Click OPEN. 

Step 8: Type any details you would like to add under DETAILS (optional). 

Step 9: Click OK. 

You will now see the attachment listed in the Summary Table. 
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To change the details of a diagnostic attachment: 

Step 1: On the SOAP bar, click LAB VALUES.

Step 2: From the Side Navigation Control, click DIAGNOSTICS.

Step 3: Select one of the attachments listed. 

Step 4: Click EDIT.  

Step 5: Type any details you would like to add or change under DETAILS. 

To detach a diagnostic attachment:

Step 1: On the SOAP bar, click LAB VALUES.

Step 2: From the Side Navigation Control, click DIAGNOSTICS.

Step 3: Select one of the attachments listed. 

Step 4: Click EDIT.  

Step 5: Click DETACH. 

The Detach confirmation screen will appear.  
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Step 6: Click YES.   

Step 7: Click SAVE.

Note: To detach all the files, click   in Step 5 above.

 

To open a diagnostic attachment:

Step 1: On the SOAP bar, click LAB VALUES.

Step 2: From the Side Navigation Control, click DIAGNOSTICS.

Step 3: Select one of the attachments listed. 

Step 4: Click OPEN FILE button. 

The file will open within the application associated with that file type. 

Note: Files can only be opened and edited if the accompanying software is installed on the

tablet. For example, if the file is a Microsoft® Word file, Microsoft® Word must be installed on

the tablet in order to edit the file. A message stating "Required program is not available" is

displayed if the software is not installed.
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6.7 Assess/Plan

The Assess/Plan section is used to document assessments, treatments, protocols, and view a

summary. This section also displays mannequins (based on the patients age and sex) with

front, back, left, and right side views. Mannequins allow multi-body part selection and can

display injury/observation selections in callouts with a line to the associated body part.

The different types of data entry in this section include:

Numeric fields

Date/Time fields

Free Text

Pick List

Summary Pick Lists

Anatomical Documentation 

*Click link above or proceed to page number listed for more information. 
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6.7.1 Anatomical

The Anatomical section allows the site of an injury/observation to be specified by charting

information on a virtual mannequin. The mannequin that appears will be based on the

documented patient sex and age. The mannequin will allow multi-body part selection and

can display injury/observation selections in callouts, with a line to the associated body part.

Multiple sets of anatomical observations associated with a specific date/time and "done

by" may be documented. 

Entering Information in Anatomical 

To enter anatomical information, select a region of the body and then select injuries and

observations associated with that region. Zooming is available for areas with small body

parts (e.g. to select the left eye on the head, or a single digit on a hand).
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Anatomical Controls:

The following describes controls available to facilitate entering data via the mannequin:

Double Arrows

Used to rotate the mannequin.

Single Arrows-

Used to position the mannequin when using zoom.

Zoom In- 

Used to zoom in on the mannequin. If grey, not available.

Zoom Out- 

Used to zoom out on the mannequin. If grey, not available.

Cancel Zoom-

To return to original view. If grey, mannequin is in original view.

Single-Body Part-

To select one body part at a time.

Multi-Body Part-

To select multiple body parts at a time. This helpful when a patient has

abrasions from head to toe. Simply tap the ‘Multi-Body Part Selection’ mode

button, select all of the injured body parts, and then select the injuries /

observations that are applicable to all body parts. 

Show/Hide Grid-

Used to show or the grid on the mannequin. Turning on the grid can help select

the most accurate position on the body.
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To enter information in Anatomical one body part a time:

Step 1: On the SOAP bar, click ASSESS/PLAN.

Step 2: Select Anatomical from the Side Navigation Control.

Step 3: Click the  ADD button. 

The anatomical screen will appear showing the mannequin. 

Step 4:  Click a region of the body.

The area will turn yellow indicating that it has been selected. 

An injury/observation Pick List will appear on the right side of the screen. The

injury/observation Pick List options will vary according to the body part selected. For

example, injuries to the eye are different than injuries that could occur to the cervical spine.

Step 5: Select  an option from the Injury Pick List.
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A Callout will now be displayed beside the injury. 

Note: The Callout can be clicked to expand. 

Step 6: Click OK.

Note: Remember when the buttons in Pick Lists are pressed twice it will be in the pertinent

negative state and will appear orange with a line through the text. By pressing the button

again it will return to the unselected state. 

To rapidly enter information in Anatomical for multiple body parts with the same

injury/observation, you can use Multi-Body Part Selection mode:

Step 1: On the SOAP bar, click ASSESS/PLAN.

Step 2: Select Anatomical from the Side Navigation Control.

Step 3: Click the  ADD button. 

The anatomical screen will appear showing the mannequin. 

Step 3: Click the Multi-Body Part button. 

Step 4:  Click the regions of the body you would like to select.

The areas will turn yellow indicating that they have been selected. 

An injury/observation Pick List will appear on the right side of the screen. The

injury/observation Pick List options will vary according to the body parts selected. 

Step 5: Select  an option from the Injury Pick List.

A Callout will now be displayed beside the injury sites. 

Note: The Callout can be clicked to expand. 

Step 6: Click OK.

Note: Remember when the buttons in Pick Lists are pressed twice it will be in the pertinent

negative state and will appear orange with a line through the text. By pressing the button

again it will return to the unselected state.  
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6.8 Outcomes

The Outcomes section is used to capture patient outcome information such as whether the

patient was treated and/or transported, cardiac arrest details, and whether stroke/CVA

systems were resolved. This section also permits documenting the supplies used during the

call, as well as reference materials associated with the ePCR.  

Entering Outcomes Information

The different types of data entry in this section include:

Numeric fields

Date/Time fields

Free Text

Pick List

Summary Pick Lists

Long Caption Pick List

*Click link above or proceed to page number listed for more information. 
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6.9 Care Plan

The Care Plan section permits documenting Primary Impression and Secondary Impressions,

the patient’s health care plan, advice provided to the patient or caregiver, and concerns

regarding the patient.  Additionally, this section can capture information pertaining to

referrals and encounters in which the EMS crew discharges the patient outside of the

hospital setting.     

Entering Information in Care Plan

The different types of data entry in this section include:

Numeric fields

Date/Time fields

Free Text

Pick List

Summary Pick Lists

Long Caption Pick List

*Click link above or proceed to page number listed for more information. 
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6.10 Review

By selecting REVIEW on the SOAP bar and PRINT PREVIEW from the Side Navigation

Control, an ePCR preview opens. You can review the report on this screen. 
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6.10.1 Print Preview Button Selections

Fax

Fax the ePCR.

Print

Send the ePCR to a printer.

Finalize

Finalize the ePCR. By finalizing an ePCR, you have identified the ePCR is complete

and accurate to the best of your knowledge.

6.10.2 Faxing ePCRs

To fax the report:

Step 1: On the SOAP bar, click REVIEW.

Step 2: Click PRINT PREVIEW from the Side Navigation Control.

Step 3: Click the  FAX button.

Step 4: Select the facility to receive the ePCR, and the fax number will populate.  

Step 5: Click OK.

Note: To facilitate secure printing, facilities must be pre-configured with fax numbers.

6.10.3 Printing ePCRs

To send the report to a printer:

Step 1: On the SOAP bar, click REVIEW.

Step 2: Click PRINT PREVIEW from the Side Navigation Control. 

Step 3: Click the  PRINT button. 

Step 4: Choose the desired print destination. 

Step 5: Click OK.

Note: A Windows print dialog may appear.

Step 6: Click OK. 

Note: A printer must be installed on the tablet or network before printing from the tablet PC.
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6.10.4 Required Fields

Required fields are specified by an administrator during installation. By selecting Required

in REVIEW, the information entered on the ePCR is analyzed to determine if any required

fields have been overlooked.

Note: Specific patient information depending on the response outcome selected from

Transport > Outcomes > General > Response Outcome will be required.  This helps to ensure

that all the patient data is collected. The ePCR cannot be marked as complete until all required

fields contain data.

Required Button Selections

Override  

Override required fields.

Link To

Link to remaining required fields that need to be completed.

Refresh

Refresh the remaining required fields.
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To complete required fields: 

Step 1: On the SOAP bar, click REVIEW.

Step 2: Click REQUIRED from the Side Navigation Control. 

All required fields will be displayed. 

The Section column lists where the field is located in the application. The Required column

identifies the required field. Items with a stop sign indicate required information, and items

with a yield sign are optional.

Step 3: Select a required field in the list and then click the  LINK TO button.  

Siren will automatically take you to the data input pane for the selected

field. The specific field for the link will be the underlined caption in red.

A Link To navigation control will appear within the Information Bar

immediately to the left of the communications lights at the top of the screen. 
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The Link To navigation control will include the following buttons: 

Previous

Navigate to the previous required field in your mandatory validation list. If the

button is greyed out, there are no more items to navigate back to. 

Next

Navigate to the next required field in your mandatory validation list. If the button

is greyed out, there are no more items to advance to.

Override

Override required fields.

Return to List

Return to the mandatory items list.

Close

Refresh the remaining required fields.

 

Step 4: Enter your data into the field within the Data Entry Pane.

Step 5: Click  PREVIOUS or  NEXT scroll buttons to navigate to the

remaining required fields. The required field caption is also listed in the Link To navigation

message box. 

Step 6: Click  RETURN TO LIST to open the required fields list and quickly link

to another field.
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Overriding Required Fields

Situations may arise that require the medic to override a required field. Overrides can be

performed directly from the toolbar. 

Overriding a Required Field:

Step 1: On the SOAP bar, click the REVIEW button.

Step 2: On the Side Navigational Control, click REQUIRED.

Step 3: From the summary table list, select the field you wish to override.

Step 4: Select the  OVERRIDE button to open a Reason for Overriding pick

list.

Step 5: Select the reason.

Step 6: Click OK.
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6.10.5 Signatures & Waivers

Signatures & Waivers button allows you to sign the ePCR. Typical signatures include crew

member, patient, and witness signatures. The types of signatures are determined by your

organization. 

To enter a signature:

Step 1: On the SOAP bar, click the REVIEW button.

Step 2: Click SIGNATURES & WAIVERS from the Side Navigation Control.

Step 3: Click the submenu button for the appropriate signature. 

A signature box appears on the Data Entry Pane.

Tip: The signature preview box can be double tapped to access the signature capture box

Step 4: Click the ENTER SIGNATURE button

A popup appears for entering the signature

Note: Crew members must enter their password again before signing the ePCR.

Note: The patient (or person reading waiver) is required to scroll through legal waivers before

signing.

Step 5: Sign on the line provided in the signature box.

Tip: When the signature box is displayed, the area outside the box (to the left, right, top, and

bottom) is disabled. This provides the signer the ability to rest their palm edge on the screen to

steady it for signing.

Step 6: Click OK.
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6.10.6 Finalize an ePCR

Finalizing an ePCR locks the ePCR so that it cannot be modified on the tablet. An ePCR

cannot be finalized until all the required fields are complete. 

To finalize an ePCR:

Step 1: On the SOAP bar, click the Review button.

Step 2: Complete the required fields.

Step 3: Click PRINT PREVIEW. 

The FINALIZE button   becomes enabled if all the required fields have been entered.

Remaining fields are listed in the required fields list. You  must enter fields indicated with a

stop sign before ePCRs can be finalized.

Step 4: Click the FINALIZE button. 

A report must be finalized before it is complete. This indicates to others on the system that

the ePCR was completed and that all of the required fields are overwritten. After the report

is finalized, it can no longer be edited on the tablet unless a web user transfers the ePCR

back.
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7 Auto ePCR Removal & Retrieval

To improve the primary medic’s access to their unfinalized ePCRs, and prevent them from

accidentally leaving finalized and unfinalized ePCRs on the tablet, Siren includes the

concepts of Auto ePCR Removal & Auto ePCR Retrieval.

Auto Removal of Unfinalized ePCRs 

When logging off Siren’s global crew list (or exiting Siren), the primary crew member of

one or more unfinalized ePCRs will be asked whether they wish for their ePCRs to be

removed from the tablet.

Selecting ‘Yes’, results in all ePCRs where that user is the primary crew, being removed

from the tablet.

Selecting ‘No’ allows the ePCRs to remain on that tablet (useful for situations in which the

crew is temporarily shutting down the tablet); however, if another crew logs in, all

unfinalized ePCRs not associated with that primary crew will be removed from the tablet

automatically.

Auto Removal of Finalized ePCRs 

All finalized ePCRs exceeding the configured ‘maximum age’ threshold will be removed

from the tablet upon starting or exiting Siren.

Manual ePCR Removal 

In addition to Auto ePCR Removal, ePCRs can be manually removed if they are unfinalized

and they are no longer required (e.g. ePCR created in error).

Finalized ePCRs cannot be manually removed.

Auto Retrieval of Unfinalized ePCRs 

When crew members login to Siren’s global crew list, all unfinalized ePCRs documented by

the primary crew member will be sent from the server to the tablet (e.g. ePCRs removed via

auto removal). The rate of arrival will vary according to network speed and server load.

When opening any ePCR, the originating Crew for the ePCR will be compared to users that

are currently logged into tablet (Global Crew List). If the crew lists differ, you will be

prompted to authenticate before opening/editing the ePCR. Only individuals who were part

of the ePCR crew list will be permitted to open the ePCR. This will mitigate the possibility

of unauthorized users viewing ePCRs for which they were not crew members. 
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